
INT-0323-rev B Page 1 

Precision Mass Flow Meter
Model 819 Series

Operating Manual

READ AND COMPLY WITH THESE INSTRUCTIONS
BEFORE INSTALLING, OPERATING, OR SERVICING
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Notice: The manufacturer reserves the right to make any changes and 

improvements to the products described in this manual at any time and without 

notice. This manual is copyrighted. This document may not, in whole or in part, 

be copied, reproduced, translated, or converted to any electronic medium or 

machine readable form, for commercial purposes, without prior written consent 

from the copyright holder. 

Note: Although we provide assistance on our products both personally and 

through our literature, it is the complete responsibility of the user to determine 

the suitability of any product to their application. 

The manufacturer does not warrant or assume responsibility for the use of its 

products in life support applications or systems. 

Warranty 

This product is warranted to the original purchaser for a period of one year 

from the date of purchase to be free of defects in material or workmanship. 

Under this warranty the product will be repaired or replaced at manufacturer’s 

option, without charge for parts or labor when the product is carried or shipped 

prepaid to the factory together with proof of purchase. This warranty does not 

apply to cosmetic items, nor to products that are damaged, defaced or otherwise 

misused or subjected to abnormal use. See “Application” under the Installation 

section. Where consistent with state law, the manufacturer shall not be liable for 

consequential economic, property, or personal injury damages. The manufacturer 

does not warrant or assume responsibility for the use of its products in life support 

applications or systems. 

Conformity / Supplemental Information: 

The product complies with the requirements of the Low Voltage Directive 2006/95/ 

EC and the EMC Directive 2004/108/EC and carries the CE Marking accordingly. 

Contact the manufacturer for more information. 
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Thank you for purchasing a MATHESON Gas Flow Meter. 

Please take the time to read the information contained in this manual. This will 
help to ensure that you get the best possible service from your instrument. This 
manual covers the following MATHESON instruments: 

819-Series Mass Gas Flow Meters

Unless otherwise noted, the instructions in this manual are applicable to all of 
the above instruments. 

Full specifications for each device can be found on pages 53 through 68. 

Please contact MATHESON at 1-800-828-4313 if you have any 
questions regarding the use or operation of this device. 
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GETTING STARTED 
Power Jack 8 Pin Mini-DIN 

Display Screen 

Inlet Connection Port 

Outlet Connection Port 

Flow Direction Arrow 

MOUNTING 
Medium Mass Flow Meter 

819-Series Gas Flow Meters have holes on the bottom for mounting to flat
panels. See pages 41-44.
819-Series Meters can usually be mounted in any position. No straight runs of
pipe are required upstream or downstream of the meter.

PLUMBING 
Your meter is shipped with plastic plugs fitted in the port openings. To 
lessen the chance of contaminating the flow stream do not remove 
these plugs until you are ready to install the device. 

Make sure that the gas will flow in the direction indicated by the flow arrow. 
Standard 819-Series Gas Flow Meters have female inlet and outlet port 
connections. Welded VCR and other specialty fittings may have male ports. 
The inlet and outlet port sizes (process connections) for different flow ranges 
are shown on pages 41-44. 
Do not use thread sealing Teflon® tape on compression fittings. 
On NPT threaded connections, do not wrap the first two threads. This will 
minimize the possibility of getting tape into the flow stream and flow body. 

Do not use pipe dopes or sealants on the process connections as these 
compounds can cause permanent damage to the meter should they get 
into the flow stream. 
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We recommend the use of in-line sintered filters to prevent large particulates 
from entering the measurement head of the instrument. Suggested maximum 
particulate sizes are as follows: 

15 microns for units with FS flow ranges between 0-100 sccm and 0-1 slpm. 
50 microns for units with FS flow ranges of 0-1 slpm or more. 

PRESSURE 
Maximum operating line pressure for 819-Series units is 150 psig (1 MPa). 
If the line pressure is higher than 150 psig (1 MPa), use a pressure regulator 
upstream from the flow meter to reduce the pressure to 150 psig (1 MPa) or less. 

Exceeding the maximum specified line pressure may cause permanent 
damage to the solid-state differential pressure sensor. 

Do Not subject an 819-Series Differential Pressure sensor to 

upstream-downstream pressure differentials exceeding 75 PSID. 

While high static pressure will typically not damage the dp 
sensor, sudden pressure “spikes” can result in complete failure 

of the sensor. 
A common cause of this problem is instantaneous application of high-
pressure gas as from a snap acting solenoid valve either upstream or 
downstream of the meter. If you suspect that your pressure sensor is 
damaged please discontinue use of the meter and contact MATHESON. 
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POWER AND SIGNAL CONNECTIONS 
Power can be supplied to your controller through either the power jack or the RJ45 
connector. 

An AC to DC adapter which converts line AC power to DC voltage and current as 
specified below is required to use the power jack. 

819 meters require a 7-30 Vdc power supply with a 2.1 mm female positive 
center plug capable of supplying at least 100mA. 

Note: 4-20mA analog output requires at least 15 Vdc. 

1 2 3 4 5 6 7 8 

RJ45 Device 

8 7 6 5 4 3 2 1 

RJ45 Cable 

1. RS-232 Receive

2. Ground

3. Analog Output

4. RS-232 Transmit

5. Power Supply

6. Power Supply

7. Analog Input

8. Ground

INPUT SIGNALS 
Analog Input Signal 

Apply analog input to Pin 7. 

Standard 0-5 Vdc is the standard analog input signal. Apply the 0-5 Vdc input 
signal to pin 7, with common ground on pin 8. 

Optional 4-20 mA: If specified at time of order, a 4-20 mA input signal can be 
applied to pin 7, with common ground on pin 8. 

NOTE: This is a current sinking device. The receiving circuit is essentially 
a 250 ohm resistor to ground. 

CAUTION! Do not connect this device to “loop powered’” systems, as 
this will destroy portions of the circuitry and void the warranty. If you 
must interface with existing loop powered systems, always use a 
signal isolator and a separate power supply. 
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RS-232 Digital Input Signal 

To use the RS-232 input signal, connect the RS-232 Output Signal (Pin 5), the 
RS-232 Input Signal (Pin 3), and Ground (Pin 8) to your computer serial port as 
shown below. (See page 22 for details on accessing RS-232) 

5  4  3  2  1 1  2  3  4  5 

9  8  7  6 

6  7  8  9 

Serial Cable End PC Serial Port 

OUTPUT SIGNALS 

RS-232 Digital Output Signal 

To use the RS-232 output signal, it is necessary to connect the RS-232 Output Signal 
 (Pin 4), the RS-232 Input Signal (Pin 1), and Ground (Pin 8) to your computer serial 
port as shown. (See page 22 for details on accessing RS-232 output.) 

Standard Voltage (0-5 Vdc) Output Signal 

829-Series flow controllers equipped with a 0-5 Vdc (optional 0-10 Vdc) will have
this output signal available on Pin 3. This output is generally available in addition
to other optionally ordered outputs. This voltage is usually in the range of 0.010
Vdc for zero flow and 5.0 Vdc for full-scale flow. The output voltage is linear over
the entire range. Ground for this signal is common on Pin 8.

Optional Current (4-20 mA) Output Signal 

If your controller was ordered with a 4-20 mA current output signal, it will 
be available on Pin 3. (See the Calibration Data Sheet that shipped with your 
controller to determine which output signals were ordered.) The current signal 
is 4 mA at 0 flow and 20 mA at the controller’s full scale flow. The output 
current is linear over the entire range. Ground for this signal is common on Pin 
8. (Current output units require 15-30Vdc power.)
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SCCM 

00123.45 

DISPLAYS AND MENUS 
The device screen defaults to Main display as soon as power is applied to the meter. 

PSIA 
+13.60

Main 

#C 
+21.50

TARE  V 

The Main display shows pressure, 
temperature, volumetric flow and mass 
flow. 
Pressing the button adjacent to a 

+0.00 Air parameter will make that parameter 
the primary display unit. 
By hitting the MENU button at the 

+0.000
CCM

+0.000
SCCM

MENU/ 
TO TA L bottom right of the screen you will 

enter the Select Menu display. 

Totalizer (option only) 
If your meter was ordered with the 
Totalizer option (page 40), pushing the 
TOTAL button once will bring up the 

TOTAL/ 
TIMER 

PEAK 
+0.0

SCCM 
+0.0 

Scm3
Totalizing Mode display. Pushing MENU 
will bring up the Select Menu display.

2:05 h:m:s 

MENU/ 
BACK  RESET MAIN 

Select Menu 
Select Menu 
From Select Menu you can change 

M IS C 

GAS 
SELECT 

MFG 
DATA 

RS232 
COMM 

MAIN 

the selected gas, interact with 
your RS-232 settings or read 
manufacturer ’s data. 
Push MAIN to return to the Main display. 
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SCCM 
Air 

MAIN 

PSIA 
+13.60

#C 
+21 .50

TARE  V 

This mode defaults on power up, with 
mass flow as the primary displayed 
parameter. 
The following parameters are displayed in 
the Main mode. 

+0.00SCCM Gas Absolute Pressure: This sensor 

+0.000
CCM

Mass Flow 

+0.000
SCCM

Air 
 

MENU/ 
TOTAL 

references hard vacuum and reads 
incoming pressure both above and below 
local atmospheric pressure. This parameter 
is moved to the primary display by pushing 
the button above PSIA. 
The engineering unit associated with 
absolute pressure is pounds per square 
inch absolute (psia). This can be converted 

to gage pressure (psig) by subtracting local atmospheric pressure from the 
absolute pressure reading: 

PSIG = PSIA – (Local Atmospheric Pressure) 
Gas Temperature: 819-Series flow meters 
measure the incoming temperature of the 
gas flow. The temperature is displayed 

UP 

>#C 
K 
#F 
#R 

DO W N M O D E in degrees Celsius (°C). This parameter is 
moved to the primary display by pushing 
the button above °C. 
Pushing the button again allows you to 
select 0C (Celsius), K (Kelvin), 0F (Fahrenheit) 
or 0R (Rankine) for the temperature scale. 

CANCEL  SET 
To select a temperature scale, use the UP 
and DOWN buttons to position the arrow in 
front of the desired scale. 
Press SET to record your selection and 
return to the MAIN display. The selected 

temperature scale will be displayed on the screen. 
Tare: Pushing the TARE V button tares the flow meter and provides it with a 
reference point for zero flow. This is an important step in obtaining accurate 
measurements. It is best to zero the flow meter each time it is powered up. If 
the flow reading varies significantly from zero after an initial tare, give the unit a 
minute or so to warm up and re-zero it. 
If possible, zero the unit near the expected operating pressure by positively blocking 
the flow downstream of the flow meter prior to pushing the TARE button. 

  Zeroing the unit while there is any flow will directly affect the accuracy 
by providing a false zero point. If in doubt about whether a zero flow 

condition exists, remove the unit from the line and positively block both ports 
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before pressing the TARE button. If the unit reads a significant negative value 
when removed from the line and blocked, it was given a false zero. It is better 
to zero the unit at atmospheric pressure and a confirmed no flow condition 
than to give it a false zero under line pressure. 

Volumetric Flow Rate: This parameter is located in the lower left of the display. 
It is moved to the primary display by pushing the button below CCM in this 
example. Your display may show a different unit of measure. 
Mass Flow Rate: The mass flow rate is the volumetric flow rate corrected to a 
standard temperature and pressure (typically 14.696 psia and 25 °C). 
This parameter is located in the lower middle of the display. It can be moved to 
the primary display by pushing the button below SCCM in this example. Your 
display may show a different unit of measure preceded by the letter S. 

  To get an accurate volumetric or mass flow rate, the gas being measured 
must be selected. See Gas Select, page 14. 

MENU: Pressing MENU switches the screen to the Select Menu display. 

Flashing Error Message: An error message (MOV = mass overrange, 
VOV = volumetric overrange, POV = pressure overrange, TOV = 
temperature overrange) flashes when a measured parameter exceeds 
the range of the sensor. When any item flashes, neither the flashing 

parameter nor the mass flow measurement is accurate. Reducing the value of 
the flashing parameter to within specified limits will return the unit to normal 
operation and accuracy. 

If the unit does not return to normal operation contact MATHESON. 
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SELECT MENU 
From Select Menu you can change the selected gas, interact with your RS-232 
settings or read manufacturer’s data. 
Press the button next to the desired operation to bring that function to the screen. 

M a t h e s o n  

MODEL 
INFO 

MISC1 MISC2 Ph  800-828-4313 
UNIT ID 

A 
BAUD 
19200 

BACK  MAIN 

BACK 
DEVICE 
UNITS  MAIN 

Manufacturer Data 
BACK  MAIN 

Miscellaneous 
Communications Select 

UP 

>Recent 
Standard

DO WN P A G E 

M IS C MFG 
DATA 

RS232 
COMM 

PSIA 
+13.60

#C 
+21.50

TARE  V 

Factory Custom 
COMPOSER User Mixes 
Bioreactor
Breathing 

GAS 
SELECT MAIN 

+ 0.00 
SCCM 
Air 

Chromatography 
Fuel 
CANCEL SELECT 

+0.000
CCM 

+0.000
SCCM M AIN 

Gas Select 
Select Menu 

Main 

An explanation for each screen can be found on the following pages. 
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GAS SELECT™ 

UP 

>Recent
Standard

DOWN P A G E 

Gas Select allows you to set your 
device to up to 150 standard gases and 
mixes. You can also use COMPOSER to 
program and store up to 20 additional 
gas mixes. 

Factory Custom 
COMPOSER User Mixes
Bioreactor
Breathing
Chromatography
Fuel

CANCEL SET 

Gas Select is accessed by pressing the 
button below GAS SELECT on the Select 
Menu display. 

To select a gas, use the UP and DOWN 
buttons to position the arrow in front of 
the desired gas category. 

UP 

> Fuel
Laser

DOWN P A G E 

O2 Concentrator
Pure Non-Corrosive
Stack
Welding

CANCEL SET 

» Recent: Eight most recent selections
» Standard: Gases and mixes standard 
MATHESON instruments (page 29)
» Factory Custom: Present only if customer 
requested gases were added at the factory
» COMPOSER User Mixes: Gas mixes 
programmed by the user (page 15)
» Bioreactor (page 31)
» Breathing (page 32)
» Chromatography (page 34)
» Fuel (page 33)
» Laser (page 33)
» O2 Concentrator (page 34)
» Pure Non-Corrosive (page 29)
» Stack (page 34)
» Welding (page 30) 

Press PAGE to view a new page in the 
gas category list. 

Press SELECT to view the gases in the selected category. Align the arrow with the 
desired gas. Press SET to record your selection and return to the MAIN display. 
The selected gas will be displayed on the screen. 

* Pure Corrosive and Refrigerant gases are only available on S-Series instruments
that are compatible with these gases.

Note: Gas Select may not be available on units ordered with a custom gas or blend.

See pages 29 - 34 for a full list of gases in each category. 
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COMPOSER™ 

UP DOWN 

COMPOSER allows you to program and 
save up to 20 custom gas mixes 
containing 2 to 5 component gases 
found in the gas lists (pages 32-39). The 

>Add Mix: 20 Free

CANCEL  SET 

minimum resolution is 0.01%. 

COMPOSER is accessed by selecting 
COMPOSER User Mixes on the GAS 
SELECT display. 

Press SET when the arrow is aligned 
with Add Mix. 

Name the mix by pressing the UP and 
DOWN buttons for letters, numerals 
and symbols. 

CHANGE CASE – Toggles the letter 
case. Letters remain in selected case 
until CHANGE CASE is pushed again. 

UP  DOWN N E X T 
L E TTE R Press SET to save the name. 

COMPOSER Mix name: 

MyGas 
------˄ 

After naming the mix, press ADD GAS 
and select the gas category and the 
component gas. 

Select the digit with arrow and adjust 
BACK/ 

CANCEL 
CHANGE 

CASE  SET 
the % with the UP and DOWN buttons. 
Press set to save. Add up to 4 more 
gases as needed. The total must equal 
100% or an error message will appear. 

GAS OPTNS allows you to adjust the 
percentage of the constituents or 
delete a gas from the mix. Gas mixes 
cannot be adjusted after they have 

EDIT 
NAME 

ADD GAS G A S 
O P T N S 

been saved. 

COMPOSER Mix: MyGAS 

0.00% of Total 

BACK/ 
CANCEL 

CHANGE 
CASE  SET 
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˄ ˄ 

˄ 

UP  DO W N S E L E C T 
D I G IT  

UP  DO W N S E L E C T 
D I G IT  

Percent of Air: 

50.00 
Percent of Ar Argon: 

30.00 

BACK/ 
CANCEL CLEAR  SET 

BACK/ 
CANCEL CLEAR  SET 

UP  DO W N S E L E C T 
D I G IT  

EDIT 
NA ME 

ADD GAS G A S 
O P T N S 

Percent of He Helium: 

20.00 

BACK/ 
CANCEL CLEAR  SET 

COMPOSER Mix: MyGAS 
50% Air 
30% AR Argon 
20% He Helium 

100.00% Total 

CANCEL SAVE 

CREATE 
NEW 

C R E A TE 
S I M IL A R 

Once the mix has been saved, you may 
press CREATE SIMILAR to compose an 
additional mix based on the mix you 
have just saved. This CREATE SIMILAR 
option is not available after leaving this 

CO MPOSER USER MIX 
MyGas 

HAS BEEN SAVED 

SELECT 

screen. 

Press CREATE NEW to add a completely 
new mix. 

MAIN MIXTURE Press SELECT MIXTURE to bring the 
custom mix onto the MAIN display. 
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COMMUNICATION SELECT 
Access Communication Select by pressing 
the button above RS232 COMM on the 
Select Menu display. 

UNIT ID 
A 

BAUD 
19200 

Unit ID – Valid unit identifiers are the 
letters A-Z and @. The identifier allows 
you to assign a unique address to each 
device so that multiple units can be 
connected to a single RS-232 computer 
port. 

BACK  MAIN Press UNIT ID. Use the UP and DOWN 
buttons to change the Unit ID. Press SET to 
record the ID. Press Reset to return to the 
previously recorded Unit ID. 
Any Unit ID change will take effect when 
Communication Select is exited. 
If the symbol @ is selected as the Unit 

UNIT ID  UP 
C 

C 

DOWN ID, the device will enter streaming mode 
when Communication Select is exited. 
See RS-232 Communications (page 22) for 
information about the streaming mode. 
Baud – Both this instrument and your 
computer must send/receive data at the 

BACK RESET  A SET same baud rate. The default baud rate for 
this device is 19200 baud. 
Press the Select button until the arrow is 
in front of Baud. Use the UP and DOWN 
buttons to select the baud rate that 
matches your computer. The choices are 
38400, 19200, 9600, or 2400 baud. 

BAUD DOWN  UP 

19200 

Any baud rate change will not take effect 
until power to the unit is cycled. 

BACK  SET 
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>
 

MISCELLANEOUS 
Miscellaneous is accessed by pressing the MISC button on the Select Menu display. 
Next select either MISC1 or MISC2. 

MISC1 will display as shown at left. 
ZERO BAND refers to Display Zero Deadband. 
Zero deadband is a value below which the display 

ZERO 
BAND 

PRESS 
AVG 

LCD 

FLOW 
AVG jumps to zero. This deadband is often desired to 

prevent electrical noise from showing up on the 
display as minor flows or pressures that do not 
exist. Display Zero Deadband does not affect the 
analog or digital signal outputs. 

BACK CONTRAST  MAIN ZERO BAND can be adjusted between 0 and 
6.3% of the sensor’s Full Scale (FS). 
Press ZERO BAND. Then use SELECT to choose 
the digit with the arrow and the UP and DOWN 
buttons to change the value. Press SET to record 
your value. Press CLEAR to return to zero. 
Pressure Averaging and Flow Averaging may 

UP  DOWN 

0.0 

SELECT be useful to make it easier to read and interpret 
rapidly fluctuating pressures and flows. Pressure 
and flow averaging can be adjusted between 1 
(no averaging) and 256 (maximum averaging). 
These are geometric running averages where 

CANCEL  CLEAR  SET the number between 1 and 256 can be 
considered roughly equivalent to the response 
time constant in milliseconds. 
This can be effective at “smoothing” high 

frequency process oscillations such as those caused by diaphragm pumps. 
Press PRESS AVG. Then use SELECT to choose the digit with the arrow and the UP and 
DOWN buttons to change the value. Press SET to record your value. Press CLEAR to 
return to zero. 
Press FLOW AVG. Then use SELECT to choose the digit with the arrow and the UP and 

DOWN buttons to change the value. Press SET to 
record your value. Press CLEAR to return to zero. 
Setting a higher number will equal a smoother 

UP  DOWN 

11 

CANCEL RESET  SET 

display. 
LCD CONTRAST: The display contrast can be 
adjusted between 0 and 31, with zero being the 
lightest and 31 being the darkest. Use the UP 
and DOWN buttons to adjust the contrast. Press 
SET when you are satisfied. Press CANCEL to 
return to the MISC display. 
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CLEAR 

101355.0 

STP/ 
NTP 

DIAG 
TEST 

ROTATE 
DISP 

MISC2 will display as shown at left. STP/NPT 
refers to the functions that allow your 
selection of standard temperature and 
pressure conditions or normal temperature 
and pressure conditions. This feature is 
generally useful for comparison purposes to 
other devices or systems using different STP 
parameters. 
The STP menu is comprised of the STP TEMP 

BACK  MAIN and STP PRESS screens. 
STP TEMP allows you to select from 0C, 0F, K 
or 0R. The arrow position will automatically 
default to the currently stored value. 
The NTP menu is comprised of the NTP TEMP 
and NTP PRESS screens. 
Once a selection has been made and recorded 

STP 
TEMP 

STP 
PRESS 

MAIN 

using the SET button, a change acknowledgement 
message will be displayed on screen. 
Selecting MAIN will revert screen to the Main 
display. If the SET selection is already the 
currently stored value, a message indicating 
that fact will appear. 
STP PRESS enables you to select from a menu 
pressure settings. Use the UP/DOWN or PAGE 
buttons to view the settings. 

The arrow position will automatically default to the currently stored value. 
Once a selection has been made and recorded using the SET button, a change 
acknowledgement message will be displayed on screen. 
Pressing SET again will revert screen to the Main display. If the SET selection is 
already the currently stored value, a message indicating that fact will appear. 

UP  DOWN SELECT 
DIGIT 

UP  DOWN SELECT 
DIGIT 

Temperature: #C 

25.0000 
Pressure: PaA 

BACK/ 
CANCEL SET 

BACK/ 
CANCEL CLEAR SET 

STP TEMP Display STP PRESS Display 



20 

R8:     AP Sig 7871 
R9:     Temp Sig 39071 
R10:    DP Side 9986 
R11:     DP Brdg 36673 
R13:    AP Brdg 36673 
R16:  Meter  Func 199 
R18:   Power  Up 32768 

SCROLL 

BACK  MAIN 

DIAG TEST: This diagnostic screen displays 
the current internal register values, which 
is useful for noting factory settings prior to 
making any changes. It is also helpful for 
troubleshooting with MATHESON customer 
service personnel. 
Select the DIAG TEST button from the MISC2 

screen to view a list of select register values. 
Pressing the SCROLL button will cycle the 
display through the register screens. An 
example screen is shown at left. 

Press ROTATE DISP and SET to Inverted 180° if your device is inverted. The 
display and buttons will rotate together. 

DEVICE UNITS 
Press DEVICE UNITS to access menus of 
units of measure for each parameter (and 
totalizer if so equipped). 

UP 
Mass Flow 

DO W N Scroll to the desired unit and press select. 
Volumetric Flow 
Pressure 
Temperature 
Mass Totalizer 
Totalizer Time 

DONE  SELECT 

Once selected, you will see the message 
shown below. Verify that all connected 
devices expect the change. 
See pages 35 and 36 for a full list of 
available units. 

UP 
SCCM 
Scm3/h 
Sm3/h 
Sm3/d 
Sin3/m 
SCFH 
NmL/s 

DO W N P A G E 
PRESSING SET WILL 

AFFECT DISPLAY 
AND SERIAL VALUES 

VERIFY  CONNECTED 
SERIAL DEVICES 

EXPECT  THE CHANGE 

CANCEL SET CANCEL SET 
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MANUFACTURER DATA 

MODEL 
INFO 

Manufacturer Data is accessed by pressing 
the MFG DATA button on the Select Menu 
display. 

The initial display shows the name and 
telephone number of the manufacturer. 

M a t h e s o n 

Ph   800-828-4313 

BACK  MAIN 

Press MODEL INFO to show important 
information about your flow device 
including the model number, serial 
number, and date of manufacture. 

Press BACK to return to the MFG DATA 
display. 

Push MAIN to return to the Main display. 

MODEL: 819-100SCCM-D 
SERIAL  NO: 100903
DATE  MFG: 10/7/2014
DATE  CAL:  10/9/2014
CAL  BY: DL 
SW REV:  5v00.G 

BACK  MAIN 
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RS-232 Output and Input 
Configuring HyperTerminal®: 

1. Open your HyperTerminal® RS-232 terminal program (installed under the
“Accessories” menu on all Microsoft Windows® operating systems).

2. Select “Properties” from the file menu.
3. Click on the “Configure” button under the “Connect To” tab. Be sure the

program is set for: 19,200 baud (or matches the baud rate selected in the
RS-232 communications menu on the meter) and an 8-N-1-None (8 Data Bits,
No Parity, 1 Stop Bit, and no Flow Control) protocol.

4. Under the “Settings” tab, make sure the Terminal Emulation is set to ANSI
or Auto Detect.

5. Click on the “ASCII Setup” button and be sure the “Send Line Ends with Line
Feeds” box is not checked and the “Echo Typed Characters Locally” box and
the “Append Line Feeds to Incoming Lines” boxes are checked. Those settings
not mentioned here are normally okay in the default position.

6. Save the settings, close HyperTerminal® and reopen it.

Streaming Mode 

In the default Polling Mode, the screen should be blank except the blinking 
cursor. In order to get the data streaming to the screen, hit the “Enter” key 
several times to clear any extraneous information. Type “*@=@” followed by 
“Enter” (or using the RS-232 communication select menu, select @ as identifier 
and exit the screen). If data still does not appear, check all the connections and 
COM port assignments. 

Streaming Mode – Advanced 

The streaming data rate is controlled by register 91. The recommended default rate 
of data provision is once every 50 milliseconds and this is suitable for most purposes. 

If a slower or faster streaming data rate is desired, register 91 can be changed to a 
value from 1 millisecond to 65535 milliseconds, or slightly over once every minute. 

Below approximately 40 milliseconds, data provision will be dependent upon 
how many parameters are selected. Fewer data parameters can be streamed 
more quickly than more. It is left to the user to balance streaming speed with 
number of parameters streamed. 

To read register 91, type “*r91” followed by “Enter”. 

To modify register 91, type “*w91=X”, where X is a positive integer from 1 to 
65535, followed by “Enter”. 

To return to the recommended factory default streaming speed, type “*w91= 50”. 
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Tareing via RS-232: 

Tare –Tareing (or zeroing) the flow meter provides it with a reference point for zero 
flow. This is a simple but important step in obtaining accurate measurements. It is 
good practice to “zero” the flow meter each time it is powered up. A unit may be 
Tared by following the instructions on page 10 or it may be Tared via RS-232 input. 

To send a Tare command via RS-232, enter the following strings: 

In Polling Mode:  Address$$V<Enter> (e.g. B$$V<Enter>) 

Changing From Streaming to Polling Mode: 

When the meter is in the Streaming Mode, the screen is updated approximately 
10-60 times per second (depending on the amount of data on each line) so that
the user sees the data essentially in real time. It is sometimes desirable, and
necessary when using more than one unit on a single RS-232 line, to be able to
poll the unit.

In Polling Mode the unit measures the flow normally, but only sends a line of data 
when it is “polled”. Each unit can be given its own unique identifier or address. 
Unless otherwise specified each unit is shipped with a default address of capital 
A. Other valid addresses are B thru Z.

Once you have established communication with the unit and have a stream of 
information filling your screen: 

1. Type *@=A followed by “Enter” (or using the RS-232 communication select
menu, select A as identifier and exit the screen) to stop the streaming mode
of information. Note that the flow of information will not stop while you
are typing and you will not be able to read what you have typed. Also, the
unit does not accept a backspace or delete in the line so it must be typed
correctly. If in doubt, simply hit enter and start again. If the unit does not
get exactly what it is expecting, it will ignore it. If the line has been typed
correctly, the data will stop.

2. You may now poll the unit by typing A followed by “Enter”. This does an
instantaneous poll of unit A and returns the values once. You may type A
“Enter” as many times as you like. Alternately you could resume streaming
mode by typing *@=@ followed by “Enter”. Repeat step 1 to remove the
unit from the streaming mode.

3. To assign the unit a new address, type *@=New Address, e.g. *@=B. Care
should be taken not to assign an address to a unit if more than one unit is
on the RS-232 line as all of the addresses will be reassigned. Instead, each
should be individually attached to the RS-232 line, given an address, and
taken off. After each unit has been given a unique address, they can all be
put back on the same line and polled individually.
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Gas Select – The selected gas can be changed via RS-232 input. To change the 
selected gas, enter the following commands: 

In Polling Mode:  Address$$#<Enter> (e.g. B$$#<Enter>) 

Where # is the number of the gas selected from the table below. Note that 
this also corresponds to the gas select menu on the flow controller screen (the 
Standard gas category is shown in the example below): 

# GAS 
0 Air Air 
1 Argon Ar 
2 Methane CH4 
3 Carbon Monoxide CO 
4 Carbon Dioxide CO2 
5 Ethane C2H6 
6 Hydrogen H2 
7 Helium He 
8 Nitrogen N2 
9 Nitrous Oxide N2O 

10 Neon Ne 
11 Oxygen O2 
12 Propane C3H8 
13 normal-Butane n-C4H10
14 Acetylene C2H2 
15 Ethylene C2H4 
16 iso-Butane i-C2H10
17 Krypton Kr 
18 Xenon Xe 
19 Sulfur Hexafluoride SF6 
20 75% Argon / 25% CO2 C-25
21 90% Argon / 10% CO2 C-10
22 92% Argon / 8% CO2 C-8
23 98% Argon / 2% CO2 C-2
24 75% CO2 / 25% Argon C-75
25 75% Argon / 25% Helium HE-75 
26 75% Helium / 25% Argon HE-25 

27 90% Helium / 7.5% Argon / 2.5% CO2 
(Praxair - Helistar® A1025) A1025 

28 90% Argon / 8% CO2 / 2% Oxygen 
(Praxair - Stargon® CS) Star29 

29 95% Argon / 5% Methane P-5

For example, to select Propane, enter: $$12<Enter> 
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Creating and Deleting Gas Mixtures with COMPOSER™ using RS-232 
Note: All commands must be prefixed with the unit ID letter. The unit should 
not be in streaming mode. 
You may create and store up to 20 gas mixtures containing up to five 
constituent gases each. The constituent gases must be chosen from the existing 
list of gases installed on the device (which may vary model to model). Please 
see pages 39 – 46 for lists of gases and their corresponding gas numbers. 
Create a Gas Mixture 
To create a gas mixture, enter a single-line command according to the following formula: 
[Unit ID] GM [Gas Name] [Gas Mix Number] [Percent 1] [Gas Number 1] 
[Percent 2] [Gas Number 2] …etc. etc. 
Notes: Do not type the brackets. There should be only one space between 
all items. Any percentages less than 1, should have a leading zero before 
the decimal (i.e. 0.25 for .25%). Trailing zeros are not necessary but they are 
allowed to help visualize the percentages on screen (as in the example). The 
sum of all percentages must be 100.00 otherwise an error will occur. 
Here is an example of a three gas mixture for a new gas called “MyMix1” 
(50% O2, 49.5% Helium, and .5% Neon), stored in user location #236, where the 
unit ID of the device is “A”: 

A GM MyMix1 236 50.00 11 49.50 7 0.50 10 <ENTER> Gas 
Name: Name your mixture using a maximum of 6 characters. 
Gas Mix Number: COMPOSER™ user mixes have MATHESON gas numbers 
between 236 and 255. You can assign any number in this range to your new 
mixture. If another mixture with the same number exists, it will be overwritten, 
even if that gas is currently selected on the unit. If you enter a 0 here, the new 
mix will be assigned the next available number between 236 and 255. 
Percent 1: The percentage of the first constituent gas. The percentage of each 
constituent must be between 0.01 and 99.99. Values entered beyond two 
decimal points will be rounded to the nearest 0.01%. 
Gas Number 1: The MATHESON gas number of the first constituent gas. 
Percent 2: The percentage of the second constituent gas. Values entered 
beyond two decimal points will be rounded to the nearest 0.01%. 
Gas Number 2: The MATHESON gas number of the second constituent gas. 
Additional Gases: (Optional) The above pattern of [Percent] + [Gas Number] 
may be repeated for additional constituent gases (up to a total of five). 
Upon success, the unit ID (if set) is returned followed by a space. The number 
of the gas mixture is then returned, followed by the percentages and names of 
each constituent in the mix. If the gas mix is not successfully created, a "?" is 
returned, and you must start over. 
Delete a Gas Mixture 
To delete a gas mixture, enter: 

[Unit ID]GD [Gas Number]: The number of the COMPOSER™ user mixture you 
wish to delete from the unit 

Only COMPOSER™ user mixtures can be deleted with this command. 
On success, the unit ID (if set) is returned followed by a space and the number of 
the gas deleted. If the gas is not successfully deleted, a "?" is returned. 
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Collecting Data: 
The RS-232 output updates to the screen many times per second. Very short-term 
events can be captured simply by disconnecting (there are two telephone symbol 
icons at the top of the HyperTerminal® screen for disconnecting and connecting) 
immediately after the event in question. The scroll bar can be driven up to the 
event and all of the data associated with the event can be selected, copied, and 
pasted into Microsoft® Excel® or other spreadsheet program as described below. 
For longer term data, it is useful to capture the data in a text file. With the desired 
data streaming to the screen, select “Capture Text” from the Transfer Menu. 
Type in the path and file name you wish to use. Push the start button. When the 
data collection period is complete, simply select “Capture Text” from the Transfer 
Menu and select “Stop” from the sub-menu that appears. 
Data that is selected and copied, either directly from HyperTerminal® or from 
a text file can be pasted directly into Excel®. When the data is pasted it will all 
be in the selected column. Select “Text to Columns...” under the Data menu in 
Excel® and a Text to Columns Wizard (dialog box) will appear. Make sure that 
“Fixed Width” is selected under Original Data Type in the first dialog box and 
click “Next”. In the second dialog box, set the column widths as desired, but the 
default is usually acceptable. Click on “Next” again. In the third dialog box, make 
sure the column data format is set to “General”, and click “Finish”. This separates 
the data into columns for manipulation and removes symbols such as the plus 
signs from the numbers. Once the data is in this format, it can be graphed or 
manipulated as desired.      For extended term data capture see page 27. 

Data Format: 
The data stream on the screen represents the flow parameters of the main mode 
in the units shown on the display. 
For mass flow meters, there are five columns of data representing pressure, 
temperature, volumetric flow, mass flow and the selected gas. 
The first column is absolute pressure (normally in psia), the second column is 
temperature (normally in °C), the third column is volumetric flow rate (in the 
units specified at time of order and shown on the display), and the fourth column 
is mass flow (also in the units specified at time of order and shown on the 
display). For instance, if the meter was ordered in units of scfm, the display on 
the meter would read 2.004 scfm and the last two columns of the output below 
would represent volumetric flow and mass flow in cfm and scfm respectively. 

+014.70 +025.00 +02.004 +02.004 Air 
+014.70 +025.00 +02.004 +02.004 Air 
+014.70 +025.00 +02.004 +02.004 Air 
+014.70 +025.00 +02.004 +02.004 Air 
Pressure Temp Vol. Flow Mass Flow Gas 

819-Series Mass Flow Meter Data Format
Note: On units with the totalizer function the fifth column will be the totalizer 
value, with gas select moving to a sixth column. 
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Sending a Simple Script File to HyperTerminal® 
It is sometimes desirable to capture data for an extended period of time. Standard 
streaming mode information is useful for short term events, however, when 
capturing data for an extended period of time, the amount of data and thus the 
file size can become too large very quickly. Without any special programming 
skills, you can use HyperTerminal® and a text editing program such as Microsoft® 
Word® to capture text at defined intervals. 
1. Open your text editing program, MS Word for example.
2. Set the cap lock on so that you are typing in capital letters.
3. Beginning at the top of the page, type A<Enter> repeatedly. If you’re using MS
Word, you can tell how many lines you have by the line count at the bottom of the
screen. The number of lines will correspond to the total number of times the flow
device will be polled, and thus the total number of lines of data it will produce.
For example:  A 

A 
A 
A 
A 
A 

will get a total of six lines of data from the flow meter, but you can 
enter as many as you like. 

The time between each line will be set in HyperTerminal. 
4. When you have as many lines as you wish, go to the File menu and select save.
In the save dialog box, enter a path and file name as desired and in the “Save as
Type” box, select the plain text (.txt) option. It is important that it be saved as a
generic text file for HyperTerminal to work with it.
5. Click Save.
6. A file conversion box will appear. In the “End Lines With” drop down box, select
CR Only. Everything else can be left as default.
7. Click O.K.
8. You have now created a “script” file to send to HyperTerminal. Close the file
and exit the text editing program.
9. Open HyperTerminal and establish communication with your flow device as
outlined in the manual.
10. Set the flow device to Polling Mode as described in the manual. Each time you
type A<Enter>, the meter should return one line of data to the screen.
11. Go to the File menu in HyperTerminal and select “Properties”.
12. Select the “Settings” tab.
13. Click on the “ASCII Setup” button.
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14. The “Line Delay” box is defaulted to 0 milliseconds. This is where you will tell
the program how often to read a line from the script file you’ve created. 1000
milliseconds is one second, so if you want a line of data every 30 seconds, you
would enter 30000 into the box. If you want a line every 5 minutes, you would
enter 300000 into the box.
15. When you have entered the value you want, click on OK and OK in the
Properties dialog box.
16. Go the Transfer menu and select “Send Text File…” (NOT Send File…).
17. Browse and select the text “script” file you created.
18. Click Open.
19. The program will begin “executing” your script file, reading one line at a time
with the line delay you specified and the flow device will respond by sending one
line of data for each poll it receives, when it receives it.
You can also capture the data to another file as described in the manual under 
“Collecting Data”. You will be simultaneously sending it a script file and capturing 
the output to a separate file for analysis. 

Operating Principle 

All 819-Series Gas Flow Meters (and 829-Series Gas Flow Controllers) are based on 
the accurate measurement of volumetric flow. The volumetric flow rate is 
determined by creating a pressure drop across a unique internal restriction, known 
as a Laminar Flow Element (LFE), and measuring differential pressure across it. 
The restriction is designed so that the gas molecules are forced to move in parallel 
paths along the entire length of the passage; hence laminar (streamline) flow 
is established for the entire range of operation of the device. Unlike other flow 
measuring devices, in laminar flow meters the relationship between pressure drop 
and flow is linear. 

STANDARD GAS DATA TABLES: Those of you who have older products may 
notice small discrepancies between the gas property tables of your old and new 
units. MATHESON has incorporated the latest data sets from NIST (including 
their REFPROP 9 data where available) in our products’ built-in gas property 
models. Be aware that the calibrators that you may be using may be checking 
against older data sets such as the widely distributed Air Liquide data. This may 
generate apparent calibration discrepancies of up to 0.6% of reading on well 
behaved gases and as much as 3% of reading on some gases such as propane and 
butane, unless the standard was directly calibrated on the gas in question. 
As the older standards are phased out, this difference in readings will cease to 
be a problem. If you see a difference between the MATHESON meter and your 
in-house standard, in addition to calling MATHESON at 800-828-4313, call the 
manufacturer of your standard for clarification as to which data set they used in 
their calibration. This comparison will in all likelihood resolve the problem. 
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GAS SELECT > Standard: 

MC Controllers will display: Acetylene, Air, Argon, Butane, Carbon Dioxide, Carbon Monoxide, Ethane, Ethylene (Ethene), Helium, Hydrogen,
Iso-Butane, Krypton, Methane, Neon, Nitrogen, Nitrous Oxide, Oxygen, Propane, Sulfur Hexafluoride, Xenon, HE-25, HE-75, A1025, C-2, C-8,
C-10, C-25, C-75, P-5, Star29.

PURE NON-CORROSIVE GASES 25°C 0°C 

Gas 

Number 

Short 

Name 
Long Name 

Absolute 

Viscosity 

Density 

14.696 PSIA 

Compressibilty 

14.696 PSIA 

Absolute 

Viscosity 

Density 

14.696 

PSIA 

Compressibilty 

14.696 PSIA 

14 C2H2 Acetylene 104.44800 1.07200 0.9928000 97.374 1.1728 0.9905 
0 Air Air 184.89890 1.18402 0.9996967 172.574 1.2930 0.9994 
1 Ar Argon 226.23990 1.63387 0.9993656 210.167 1.7840 0.9991 

16 i-C4H10 i-Butane 74.97846 2.44028 0.9735331 68.759 2.6887 0.9645 
13 n-C4H10 n-Butane 74.05358 2.44930 0.9699493 67.690 2.7037 0.9591 
4 CO2 Carbon Dioxide 149.31840 1.80798 0.9949545 137.107 1.9768 0.9933 
3 CO Carbon Monoxide 176.49330 1.14530 0.9996406 165.151 1.2505 0.9993 

60 D2 Deuterium 126.59836 0.16455 1.0005970 119.196 0.1796 1.0006 
5 C2H6 Ethane 93.54117 1.23846 0.9923987 86.129 1.3550 0.9901 

15 C2H4 Ethylene (Ethene) 103.18390 1.15329 0.9942550 94.697 1.2611 0.9925 
7 He Helium 198.45610 0.16353 1.0004720 186.945 0.1785 1.0005 
6 H2 Hydrogen 89.15355 0.08235 1.0005940 83.969 0.0899 1.0006 

17 Kr Krypton 251.32490 3.43229 0.9979266 232.193 3.7490 0.9972 
2 CH4 Methane 110.75950 0.65688 0.9982472 102.550 0.7175 0.9976 

10 Ne Neon 311.12640 0.82442 1.0004810 293.822 0.8999 1.0005 
8 N2 Nitrogen 178.04740 1.14525 0.9998016 166.287 1.2504 0.9995 
9 N2O Nitrous Oxide 148.41240 1.80888 0.9945327 136.310 1.9779 0.9928 

11 O2 Oxygen 205.50210 1.30879 0.9993530 191.433 1.4290 0.9990 
12 C3H8 Propane 81.46309 1.83204 0.9838054 74.692 2.0105 0.9785 
19 SF6 Sulfur Hexafluoride 153.53200 6.03832 0.9886681 140.890 6.6162 0.9849 
18 Xe Xenon 229.84830 5.39502 0.9947117 212.157 5.8980 0.9932 
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WELDING GASES 25°C 0°C 

Gas 

Number 

Short 

Name 
Long Name 

Absolute 

Viscosity 

Density 

14.696 PSIA 

Compressibilty 

14.696 PSIA 

Absolute 

Viscosity 

Density 

14.696 PSIA 

Compressibilty 

14.696 PSIA 

23 C-2 2% CO2 / 98% Ar 224.71480 1.63727 0.9993165 208.673 1.7877 0.998993 
22 C-8 8% CO2 / 92% Ar 220.13520 1.64749 0.9991624 204.199 1.7989 0.9987964 
21 C-10 10% CO2 / 90% Ar 218.60260 1.65091 0.9991086 202.706 1.8027 0.9987278 

140 C-15 15% CO2 / 85% Ar 214.74960 1.65945 0.9989687 198.960 1.8121 0.9985493 
141 C-20 20% CO2 / 80% Ar 210.86960 1.66800 0.9988210 195.198 1.8215 0.9983605 
20 C-25 25% CO2 / 75% Ar 206.97630 1.67658 0.9986652 191.436 1.8309 0.9981609 

142 C-50 50% CO2 / 50% Ar 187.53160 1.71972 0.9977484 172.843 1.8786 0.9969777 
24 C-75 75% CO2 / 25% Ar 168.22500 1.76344 0.9965484 154.670 1.9271 0.995401 
25 He-25 25% He / 75% Ar 231.60563 1.26598 0.9996422 216.008 1.3814 0.9999341 

143 He-50 50% He / 50% Ar 236.15149 0.89829 0.9999188 220.464 0.9800 1.00039 
26 He-75 75% He / 25% Ar 234.68601 0.53081 1.0001954 216.937 0.5792 1.000571 

144 He-90 90% He / 10% Ar 222.14566 0.31041 1.0003614 205.813 0.3388 1.00057 
27 A1025 90%He/ 7.5%Ar / 2.5%CO2 214.97608 0.31460 1.0002511 201.175 0.3433 1.000556 

28 Star29 
Stargon CS 90% Ar / 

8% CO2 / 2% O2 
219.79340 1.64099 0.9991638 203.890 1.7918 0.998798 
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BIOREACTOR GASES 25°C 0°C 

Gas 

Number 

Short 

Name 
Long Name 

Absolute 

Viscosity 

Density 

14.696 PSIA 

Compressibilty 

14.696 PSIA 

Absolute 

Viscosity 

Density 

14.696 PSIA 

Compressibilty 

14.696 PSIA 

145 Bio-5M 5% CH4 / 95% CO2 148.46635 1.75026 0.9951191 136.268 1.9134 0.9935816 
146 Bio-10M 10% CH4 / 90% CO2 147.54809 1.69254 0.9952838 135.383 1.8500 0.993893 
147 Bio-15M 15% CH4 / 85% CO2 146.55859 1.63484 0.9954484 134.447 1.7867 0.9941932 
148 Bio-20M 20% CH4 / 80% CO2 145.49238 1.57716 0.9956130 133.457 1.7235 0.994482 
149 Bio-25M 25% CH4 / 75% CO2 144.34349 1.51950 0.9957777 132.407 1.6603 0.9947594 
150 Bio-30M 30% CH4 / 70% CO2 143.10541 1.46186 0.9959423 131.290 1.5971 0.9950255 
151 Bio-35M 35% CH4 / 65% CO2 141.77101 1.40424 0.9961069 130.102 1.5340 0.9952803 
152 Bio-40M 40% CH4 / 60% CO2 140.33250 1.34664 0.9962716 128.834 1.4710 0.9955239 
153 Bio-45M 45% CH4 / 55% CO2 138.78134 1.28905 0.9964362 127.478 1.4080 0.9957564 
154 Bio-50M 50% CH4 / 50% CO2 137.10815 1.23149 0.9966009 126.025 1.3450 0.9959779 
155 Bio-55M 55% CH4 / 45% CO2 135.30261 1.17394 0.9967655 124.462 1.2821 0.9961886 
156 Bio-60M 60% CH4 /40% CO2 133.35338 1.11642 0.9969301 122.779 1.2193 0.9963885 
157 Bio-65M 65% CH4 /35% CO2 131.24791 1.05891 0.9970948 120.959 1.1564 0.9965779 
158 Bio-70M 70% CH4 / 30% CO2 128.97238 1.00142 0.9972594 118.987 1.0936 0.9967567 
159 Bio-75M 75% CH4 / 25% CO2 126.51146 0.94395 0.9974240 116.842 1.0309 0.9969251 
160 Bio-80M 80% CH4 / 20% CO2 123.84817 0.88650 0.9975887 114.501 0.9681 0.9970832 
161 Bio-85M 85% CH4 / 15% CO2 120.96360 0.82907 0.9977533 111.938 0.9054 0.9972309 
162 Bio-90M 90% CH4 / 10% CO2 117.83674 0.77166 0.9979179 109.119 0.8427 0.9973684 
163 Bio-95M 95% CH4 / 5% CO2 114.44413 0.71426 0.9980826 106.005 0.7801 0.9974957 
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BREATHING GASES 25°C 0°C 

Gas 

Number 

Short 

Name 
Long Name 

Absolute 

Viscosity 

Density 

14.696 PSIA 

Compressibilty 

14.696 PSIA 

Absolute 

Viscosity 

Density 

14.696 PSIA 

Compressibilty 

14.696 PSIA 

164 EAN-32 32% O2 / 68% N2 186.86315 1.19757 0.9996580 174.925 1.3075 0.9993715 
165 EAN 36% O2 / 64% N2 187.96313 1.20411 0.9996401 175.963 1.3147 0.9993508 
166 EAN-40 40% O2 / 60% N2 189.06268 1.21065 0.9996222 176.993 1.3218 0.9993302 
167 HeOx-20 20% O2 / 80% He 217.88794 0.39237 1.0002482 204.175 0.4281 1.000593 
168 HeOx-21 21% O2 / 79% He 218.15984 0.40382 1.0002370 204.395 0.4406 1.000591 
169 HeOx-30 30% O2 / 70% He 219.24536 0.50683 1.0001363 205.140 0.5530 1.000565 
170 HeOx-40 40% O2 / 60% He 218.59913 0.62132 1.0000244 204.307 0.6779 1.000502 
171 HeOx-50 50% O2 / 50% He 216.95310 0.73583 0.9999125 202.592 0.8028 1.000401 
172 HeOx-60 60% O2 / 40% He 214.82626 0.85037 0.9998006 200.467 0.9278 1.000257 
173 HeOx-80 80% O2 / 20% He 210.11726 1.07952 0.9995768 195.872 1.1781 0.9998019 
174 HeOx-99 99% O2 / 1% He 205.72469 1.29731 0.9993642 191.646 1.4165 0.9990796 
175 EA-40 Enriched Air-40% O2 189.42518 1.21429 0.9996177 177.396 1.3258 0.9993261 
176 EA-60 Enriched Air-60% O2 194.79159 1.24578 0.9995295 182.261 1.3602 0.9992266 
177 EA-80 Enriched Air-80% O2 200.15060 1.27727 0.9994412 186.937 1.3946 0.9991288 

178 
Metabol Metabolic Exhalant (16% 

O2 / 78.04% N2 / 5% 
CO2 / 0.96% Ar)

180.95936 1.20909 0.9994833 170.051 1.3200 0.9992587 
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FUEL GASES 25°C 0°C 

Gas 

Number 

Short 

Name 
Long Name 

Absolute 

Viscosity 

Density 

14.696 PSIA 

Compressibilty 

14.696 PSIA 

Absolute 

Viscosity 

Density 

14.696 PSIA 

Compressibilty 

14.696 PSIA 

185 Syn Gas-1 40% H2 + 29% CO + 20% CO2 + 11% CH4 155.64744 0.79774 0.9989315 144.565 0.8704 0.9992763 
186 Syn Gas-2 64% H2 + 28% CO + 1% CO2 + 7% CH4 151.98915 0.43715 1.0001064 142.249 0.4771 1.000263 
187 Syn Gas-3 70% H2 + 4% CO + 25% CO2 + 1% CH4 147.33686 0.56024 0.9991225 136.493 0.6111 0.9997559 
188 Syn Gas-4 83%H2+14%CO+3%CH4 133.63682 0.24825 1.0003901 125.388 0.2709 1.000509 

189 Nat Gas-1 93%CH4/ 3%C2H6 /1%C3H8/ 2%N2/1% CO2 111.77027 0.70709 0.9979255 103.189 0.7722 0.9973965 

190 Nat Gas-2 95% CH4 / 3% C2H6 / 1% N2 / 1% CO2 111.55570 0.69061 0.9980544 103.027 0.7543 0.9974642 

191 Nat Gas-3 
95.2% CH4 / 2.5% C2H6 / 0.2% C3H8 / 0.1% 

C4H10 / 1.3% N2 / 0.7% CO2 111.49608 0.68980 0.9980410 102.980 0.7534 0.9974725 

192 Coal Gas 50% H2 / 35% CH4 / 10% CO / 5% C2H4 123.68517 0.44281 0.9993603 115.045 0.6589 0.996387 
193 Endo 75% H2 + 25% N2 141.72100 0.34787 1.0005210 133.088 0.3797 1.000511 
194 HHO 66.67% H2 / 33.33% O2 180.46190 0.49078 1.0001804 168.664 0.5356 1.000396 

195 HD-5 
LPG 96.1% C3H8/  1.5% C2H6/  0.4% C3H6/  1.9% n-

C4H10 81.45829 1.83428 0.9836781 74.933 2.0128 0.9784565 

196 HD-10 LPG 85% C3H8 / 10% C3H6 / 5% n-C4H10 81.41997 1.85378 0.9832927 74.934 2.0343 0.9780499 

LASER GASES 25°C 0°C 

Gas 

Number 

Short 

Name 
Long Name 

Absolute 

Viscosity 

Density 

14.696 PSIA 

Compressibilty 

14.696 PSIA 

Absolute 

Viscosity 

Density 

14.696 PSIA 

Compressibilty 

14.696 PSIA 

179 LG-4.5 4.5% CO2 / 13.5% N2 / 82% He 199.24300 0.36963 1.0001332 187.438 0.4033 1.000551 
180 LG-6 6% CO2 / 14% N2 / 80% He 197.87765 0.39910 1.0000471 186.670 0.4354 1.00053 
181 LG-7 7% CO2 / 14% N2 / 79% He 197.00519 0.41548 0.9999919 186.204 0.4533 1.000514 
182 LG-9 9% CO2 / 15% N2 / 76% He 195.06655 0.45805 0.9998749 184.835 0.4997 1.000478 
183 HeNe-9 9% Ne / 91% He 224.68017 0.22301 1.0004728 211.756 0.2276 1.000516 
184 LG-9.4 9.4% CO2 / 19.25% N2 / 71.35% He 193.78311 0.50633 0.9998243 183.261 0.5523 1.000458 
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O2 CONCENTRATOR GASES 25°C 0°C 

Gas 

Number 

Short 

Name 
Long Name 

Absolute 

Viscosity 

Density 

14.696 PSIA 

Compressibilty 

14.696 PSIA 

Absolute 

Viscosity 

Density 

14.696 PSIA 

Compressibilty 

14.696 PSIA 

197 OCG-89 89% O2 / 7% N2 / 4% Ar 204.53313 1.31033 0.9993849 190.897 1.4307 0.9990695 
198 OCG-93 93% O2 / 3% N2 / 4% Ar 205.62114 1.31687 0.9993670 191.795 1.4379 0.9990499 
199 OCG-95 95% O2 / 1% N2 / 4% Ar 206.16497 1.32014 0.9993580 192.241 1.4414 0.99904 

STACK GASES 25°C 0°C 

Gas 

Number 

Short 

Name 
Long Name 

Absolute 

Viscosity 

Density 

14.696 PSIA 

Compressibilty 

14.696 PSIA 

Absolute 

Viscosity 

Density 

14.696 PSIA 

Compressibilty 

14.696 PSIA 

200 FG-1 
2.5% O2 / 10.8% CO2 / 85.7% N2 / 

1% Ar 
175.22575 1.22550 0.9992625 165.222 1.3379 0.9990842 

201 FG-2 
2.9% O2 / 14% CO2 / 82.1% N2 / 

1% Ar 
174.18002 1.24729 0.9991056 164.501 1.3617 0.9989417 

202 FG-3 
3.7% O2 / 15% CO2 / 80.3% N2 / 

1% Ar 
174.02840 1.25520 0.9990536 164.426 1.3703 0.9988933 

203 FG-4 7% O2 / 12% CO2 / 80% N2 / 1% Ar 175.95200 1.24078 0.9991842 166.012 1.3546 0.9990116 

204 FG-5 
10% O2 / 9.5% CO2 / 79.5% N2 / 

1% Ar 
177.65729 1.22918 0.9992919 167.401 1.3419 0.9991044 

205 FG-6 13% O2 / 7% CO2 / 79% N2 / 1% Ar 179.39914 1.21759 0.9993996 168.799 1.3293 0.9991932 

CHROMATOGRAPHY GASES 25°C 0°C 

Gas 

Number 

Short 

Name 
Long Name 

Absolute 

Viscosity 

Density 

14.696 PSIA 

Compressibilty 

14.696 PSIA 

Absolute 

Viscosity 

Density 

14.696 PSIA 

Compressibilty 

14.696 PSIA 

29 P-5 5% CH4 / 95% Ar 223.91060 1.58505 0.9993265 207.988 1.7307 0.9990036 
206 P-10 10% CH4 90% Ar 221.41810 1.53622 0.9992857 205.657 1.6774 0.99895 
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Supported Units: This device supports many different units. You may select the desired units( see page 28). Note that 
only units appropriate to this device are available for selection. 

Pressure Units 

Absolute Gauge Differential Notes 

PaA PaG PaD pascal 

hPaA hPaG hPaD hectopascal 

kPaA kPaG kPaD kilopascal 

MPaA MPaG MPaD megapascal 

mbarA mbarG mbarD millibar 

barA barG barD bar 

g/cm2A g/cm2G g/cm2D gram  force  per    square  centimeter 

kg/cmA kg/cmG kg/cmD kilogram  force       per  square  centimeter 

PSIA PSIG PSID pound  force  per  square  inch 

PSFA PSFG PSFD pound  force  per  square  foot 

mTorrA mTorrG mTorrD millitorr 

torrA torrG torrD torr 

mmHgA mmHgG mmHgD millimeter  of  mercury   at  0  C 

inHgA inHgG inHgD inch  of  mercury  at  0  C 

mmH2OA mmH2OG mmH2OD millimeter  of      water  at  4  C  (NIST  conventional) 

mmH2OA mmH2OG mmH2OD millimeter  of  water  at  60  C 

cmH2OA cmH2OG cmH2OD centimeter  of  water  at  4  C  (NIST  conventional) 

cmH2OA cmH2OG cmH2OD centimeter  of  water  at  60  C 

inH2OA inH2OG inH2OD inch  of  water  at  4  C  (NIST  conventional) 

inH2OA inH2OG inH2OD inch  of  water  at  60   C 

atm atmosphere 

m  asl meter  above  sea  level  (only  in  / ALT  builds) 

ft asl foot  above  sea  level      (only  in  / ALT  builds) 

V volt;     no  conversions    are  performed  to  or  from  other  units 

count count count setpoint  count,  0 – 64000 

% % % percent  of  full  scale 

Flow Units 

Volumetric Standard Normal Notes 

uL/m SuL/m NuL/m microliter  per  minute 

mL/s SmL/s NmL/s milliliter  per     second 

mL/m SmL/m NmL/m milliliter  per  minute 

mL/h Sml/h NmL/h milliliter  per  hour 

L/s SL/s NL/s liter   per  second 

LPM SLPM NLPM liter  per  minute 

L/h SL/h NL/h liter      per  hour 

US GPM US  gallon  per  minute 

US GPH US  gallon  per  hour 

CCS SCCS NCCS cubic  centimeter     per          second 

CCM SCCM NCCM cubic  centimeter  per  minute 

cm3/h Scm3/h Ncm3/h cubic  centimeter  per  hour 

m3/m Sm3/m Nm3/m cubic  meter  per  minute 

m3/h Sm3/h Nm3/h cubic  meter   per  hour 

m3/d Sm3/d Nm3/d cubic  meter         per  day 

in3/m Sin3/m cubic  inch  per  minute 

CFM SCFM cubic  foot  per  minute 

CFH SCFH cubic  foot  per  hour 

kSCFM 1000  cubic  feet   per  minute 

count count count Setpoint  count,       0 – 64000 

% % % percent  of  full  scale 
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True Mass Flow Units 

Label Notes 

mg/s milligram  per  second 

mg/m milligram  per  minute 

g/s gram  per  second 

g/m gram   per  minute 

g/h gram  per  hour 

kg/m kilogram  per  minute 

kg/h kilogram  per  hour 

oz/s ounce  per  second 

oz/m ounce  per  minute 

lb/m pound     per  minute 

lb/h pound  per  hour 
These can be used for mass flow on gas devices. These can also be used for volumetric flow on liquid 

devices calibrated in one of these units (liquid density is not yet supported). 

Totalizer Units 

Volumetric Standard Normal Notes 

uL SuL NuL microliter 

mL SmL NmL milliliter 

L SL NL liter 

US GAL US     gallon 

cm3 Scm3 Ncm3 cubic  centimeter 

m3 Sm3 Nm3 cubic    meter 

in3 Sin3 cubic  inch 

ft3 Sft3 cubic  foot 

kSft3 1000  cubic  feet 

uP 
micropoise, a measure of viscosity; no conversions are performed to or from 
other units 

Total Mass Units 

Label Notes 

mg milligram 

g gram 

kg kilogram 

oz ounce 

lb pound 

These can be used for totalized mass on gas devices. These can also be used for totalized 

volume on liquid devices calibrated in one of these units (liquid density is not yet supported). 

Temperature Units 

Label Notes 

°C degree  Celsius 

°F degree  Farenheit 

K Kelvin 

°R degree     Rankine 

Time Units 

Label Notes 

h:m:s Displayed    value  is  hours:minutes:seconds 

ms millisecond 

s second 

m minute 

hour hour 

day day 
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TROUBLESHOOTING 

Display does not come on or is weak. 
Check power and ground connections. Please reference the technical specifications 
(pages 41-44) to assure you have the proper power for your model. 

Flow reading is approximately fixed either near zero or near full scale regardless 
of actual line flow. 
Differential pressure sensor may be damaged. Avoid installations that can subject 
the sensor to excessive pressure differentials (see page 7). A common cause of this 
problem is instantaneous application of high-pressure gas as 
from a snap acting solenoid valve upstream of the meter. If you suspect that your 
pressure sensor is damaged please discontinue use of the meter and contact 
MATHESON. 

Displayed mass flow, volumetric flow, pressure or temperature is flashing and 
message MOV, VOV, POV or TOV is displayed: 
Our flow meters and controllers display an error message (MOV = mass overrange, 
VOV = volumetric overrange, POV = pressure overrange, TOV = temperature 
overrange) when a measured parameter exceeds the range of the sensors in the 
device. When any item flashes on the display, neither the flashing parameter nor 
the mass flow measurement is accurate. Reducing the value of the flashing 
parameter to within specified limits will return the unit to normal operation and 
accuracy. If the unit does not return to normal contact MATHESON. 

Meter reads negative flow when there is a confirmed no flow condition. 
This is an indication of an improper tare. If the meter is tared while there is flow, 
that flow is accepted as zero flow. When an actual zero flow condition exists, the 
meter will read a negative flow. Simply re-tare at the confirmed zero flow 
condition. Also note that while the meter is intended for positive flow, it will read 
negative flow with reasonable accuracy, but not to the full scale flow rate and no 
damage will result. 

Meter does not agree with another meter I have in line. 
Volumetric meters are affected by pressure drops. Volumetric flow meters should 
not be compared to mass flow meters. Mass flow meters can be compared against 
one another provided there are no leaks between the two meters and they are set 
to the same standard temperature and pressure. Both meters must also be 
calibrated (or set) for the gas being measured. 819-Series mass flow meters are 
normally set to Standard Temperature and Pressure conditions of 25° C and 14.696 
psia. Note: it is possible to special order meters with a customer specified set of 
standard conditions. The calibration sheet provided with each meter lists its 
standard conditions. 
When performing this comparison it is best to use the smallest transition possible 
between the two devices. Using small transitions will minimize lag and dead 
volume. 
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Flow flutters or is jumpy. 
The meters are very fast and will pick up any actual flow fluctuations such as from a 
diaphragm pump, etc. Also, inspect the inside of the upstream connection for debris 
such a Teflon tape shreds. 
Note: 819-Series meters feature a programmable geometric running average (GRA) 
that can aid in allowing a rapidly fluctuating flow to be read (see “Pressure Averaging” 
and “Flow Averaging” page 18). 

The output signal is lower than the reading at the display. 
This can occur if the output signal is measured some distance from the meter, 
as voltage drops in the wires increase with distance. Using heavier gauge wires, 
especially in the ground wire, can reduce this effect. 

RS-232 Serial Communications is not responding. 
Check that your meter is powered and connected properly. Be sure that the 
port on the computer to which the meter is connected is active. Confirm that 
the port settings are correct per the RS-232 instructions in this manual (Check 
the RS-232 communications select screen for current meter readings). Close 
Hyperterminal® and reopen it. Reboot your PC. See pages 9 and 22 for more 
information on RS-232 signals and communications. 

Slower response than specified. 
819-Series Meters feature a programmable Geometric Running Average
(GRA). Depending on the full scale range of the meter, it may have the GRA
set to enhance the stability/readability of the display, which would result in
slower perceived response time. Please see “Pressure Averaging” and “Flow
Averaging” on page 18.

Jumps to zero at low flow. 
819-Series Meters feature a programmable zero deadband. The factory setting
is usually 0.5% of full scale. This can be adjusted between NONE and 6.3% of
full scale. See page 18.

Discrepancies between old and new units. 
Please see “Standard Gas Data Tables” explanation on page 28. 
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Maintenance and Recalibration 

General: 819-Series Flow Meters require minimal maintenance. They have no 
moving parts. The single most important thing that affects the life and accuracy 
of these devices is the quality of the gas being measured. The meter is designed 
to measure CLEAN, DRY, NON-CORROSIVE gases. 

Moisture, oil and other contaminants can affect the laminar flow elements. 
We recommend the use of in-line sintered filters to prevent large particulates 
from entering the measurement head of the instrument. Suggested maximum 
particulate sizes are as follows: 

15 microns for units with FS flow ranges between 0-100 sccm and 0-1 slpm. 
50 microns for units with FS flow ranges of 0-1 slpm or more. 

Recalibration: The recommended period for recalibration is once every year. 
A label located on the back of the meter lists the most recent calibration date. 
The meter should be returned to the factory for recalibration within one year 
from the listed date. Before calling to schedule a recalibration, please note the 
serial number on the back of the meter. The Serial Number, Model Number, and 
Date of Manufacture are also available on the Model Info display (page 21). 

Cleaning: 819-Series Flow Meters require no periodic cleaning. If necessary, the 
outside of the meter can be cleaned with a soft dry cloth. Avoid excess moisture 
or solvents. 

For repair, recalibration or recycling of this product contact: 

MATHESON 
166 Keystone Drive 

Montgomeryville, PA 18936 
Ph: 800-828-4313 

Web: www.mathesongas.com 

http://www.mathesongas.com/
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+123.45 

Option: Totalizing Mode - Meters 
Meters can be purchased with the Totalizing Mode option. This option adds an 
additional mode screen that displays the total flow (normally in the units of the 
main flow screen) that has passed through the device since the last time the 
totalizer was cleared. The Totalizing Mode screen is accessed by pushing the 
TOTAL/TIMER button on the MAIN display. 

TOTAL/TIMER: Pushing the TOTAL/TIMER button 
will  cycle  the  large  numbers  on  the  display 

TOTAL/ 
TIMER 

SETPT 
+123.4

SCCM 
+123.4

Scm3

between total mass and time elapsed. 
Rollover – The customer can also specify at the 
time of order what the totalizer is to do when 

50:56 h:m:s 

the maximum count is reached. The following 
options may be specified: 

BATCH  RESET 
MENU/ 

MAIN 
No Rollover – When the counter reaches the 
maximum count it stops counting until the 
counter is cleared. 
Rollover  –  When  the  counter  reaches  the 

maximum count it automatically rolls over to zero and continues counting until 
the counter is cleared. 
Rollover with Notification – When the counter reaches the maximum count 
it automatically rolls over to zero, displays an overflow error, and continues 
counting until the counter is cleared. 
TOTAL MASS: The counter can have as many as seven digits. At the time of order, 
the customer must specify the range. This directly affects the maximum count. For 
instance, if a range of 1/100ths of a liter is specified on a meter which is totalizing in 
liters, the maximum count would be 99999.99 liters. If the same unit were specified 
with a 1 liter range, the maximum count would be 9999999 liters. 
ELAPSED TIME: The small numbers below the mass total show the elapsed time 
since the last reset in hours, minutes and seconds. The maximum measurable 
elapsed time is 9999 hours 59 minutes 59 seconds. The hours count resets when 
RESET is pushed, an RS-232 clear is executed or on loss of power. Press TOTAL/ 
TIMER to show this as the primary display. 
SETPT: Pushing SETPT will allow you to change the controller's set-point. 
RESET – The counter can be reset to zero at any time by pushing the RESET 
button. To clear the counter via RS-232, establish serial communication with the 
meter or controller as described in the RS-232 section of the manual. To reset the 
counter, enter the following commands: 

In Polling (addressable) Mode:  Address$$T <Enter> (e.g. B$$T <Enter>) 
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Technical Data for 819-Series Mass Flow Meters 
0 to 100 sccm Full Scale through 0 to 250 slpm Full Scale 

Standard Operating Specifications (Contact MATHESON for available options) 

Performance 819-Series Mass Flow Meter 

Accuracy at calibration conditions 

after tare 
± (0.8% of Reading + 0.2% of Full Scale) 

Repeatability ± 0.2% Full Scale 

Zero Shift and Span Shift 0.02% Full Scale / ºCelsius / Atm 

Operating Range / Turndown Ratio 0.5% to 100% Full Scale / 200:1 Turndown 

Maximum Measurable Flow Rate 128% Full Scale 

Typical Response Time 10 ms (Adjustable) 

Warm-up Time < 1 Second 

Operating Conditions 819-Series Mass Flow Meter 

Mass Reference Conditions (STP) 25ºC & 14.696 psia (standard — others available on request) 

Operating Temperature −10 to +50 ºCelsius 

Humidity Range (Non–Condensing) 0 to 100% 

Maximum Pressure 150 psig 

Mounting Attitude Sensitivity None 

Ingress Protection IP40 

Wetted Materials 

303 & 302 Stainless Steel, Viton®, Heat Cured Silicone Rubber, Glass 

Reinforced Polyphenylene Sulfide, Heat Cured Epoxy, Aluminum, Gold, Silicon, 

Glass. 

If your application demands a different material, please contact MATHESON. 

Communications / Power 819-Series Mass Flow Meter 

Monochrome LCD Display with 

integrated touchpad 
Simultaneously displays Mass Flow, Volumetric Flow, Pressure and Temperature 

Digital Output Signal1 Options RS-232 Serial 

Analog Output Signal2 Options 0-5 Vdc / 4-20 mA 

Electrical Connection Options RJ45 

Supply Voltage 7 to 30 Vdc (15-30 Vdc for 4-20 mA outputs) 

Supply Current 0.040 Amp (+ output current on 4-20 mA) 

1. The Digital Output Signal communicates Mass Flow, Volumetric Flow, Pressure and Temperature 

2. The Analog Output Signal communicate your choice of Mass Flow, Volumetric Flow, Pressure or Temperature 

Range Specific Specifications 

Full Scale Flow Mass 

Meter 
Pressure Drop at FS Flow 

(psid) venting to atmosphere1
 

Mechanical 

Dimensions 
Process Connections2

 

100 sccm to 20 slpm 1.0 4.1”H x 2.4”W x 1.1”D 1/8” NPT Female 

50 slpm 2.0 
4.4”H x 4.0”W x 1.6”D 1/4” NPT Female 

100 slpm 2.5 

250 slpm 2.1 5.0”H x 4.0”W x 1.6”D 1/2” NPT Female 

1. Compatible with Swagelok® tube, Parker®, face seal, push connect and compression adapter fittings. VCR and SAE 

connections upon request. 
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67mm  50in 

 

26.67mm 

1.050in 

[8.53mm] 
.336in 

98.98mm 
3.897in 

[8.53mm] 

.336in 

[13.34mm] 
.525in M5X0.8  (10-32 UNF) 

Both Sides 

2.375in 

56.52mm 
2.225in 

3.81mm 
.150in 

3.175mm 
.125in 

23.495mm 
.925in 

.525in 

819-Series:

0 – 0.5 sccm 

0 – 1 sccm 

0 – 2 sccm 

0 – 5 sccm 

2X 8-32 UNC .175in[4.45mm] 

0.5 sccm to 50 sccm approximate shipping weight: 0.8 lb 

0 – 10 sccm 

0 – 20 sccm 

0 – 50 sccm 
DATE 

1/4/2016 

M-0.5SCCM-D-MSPEC
REV. 

1 

26. 
1.0 

103.30mm 

4.067in 

8.89mm 

.350in 
8.89mm 
.350in 

13.34mm 
.525in 

1/8 NPT 
Both Sides 

2X 8-32 UNC .350in 8.89mm 

60.33mm 
2.375in 

56.52mm 
2.225in 

3.81mm 
.150in 

3.18mm 
.125in 

23.50mm 
.925in 

13.34mm 
.525in 

819-Series:

0 – 100 sccm 

0 – 200 sccm 

0 – 500 sccm 

0 – 1 slpm 

0 – 2 slpm 

0 – 5 slpm 

0 – 10 slpm 
M-20SLPM-D-MSPEC 

0 – 20 slpm 

DATE 

1/4/2016 

REV. 

1 

100 sccm to 20 slpm approximate shipping weight: 1.0 lb 



819-Series:

0 – 50 slpm 

0 – 100 slpm 
40.64mm 
1.600in 

110.92mm 
4.367in 

12.70mm 
.500in 

12.70mm 
.500in 

1/4 NPT 
Both sides 20.32mm 

.800in 
101.60mm 

4.000in 
20.32mm 

.800in 

82.55mm 
3.250in 4.45mm 

.175in 19.05mm 
.750in 

36.20mm 
1.425in 4X 8-32 UNC .375in[9.53mm] 

DATE 

1/4/2016 

REV. 

1 

250 slpm approximate shipping weight: 3.2 lb. 
M-250SLPM-D-MSPEC 
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82.55mm 
3.250in 

19.05mm 

.750in 

4.45mm 
.175in 

4X 8-32 UNC .375in[9.53mm] 

36.20mm 
1.425in 

50 slpm to 100 slpm approximate shipping weight: 2.4 lb. DATE 

1/4/2016 

M-50SLPM-D-MSPEC 
REV. 

1 

40.64mm 

1.600in 
0 – 250 slpm 

101.60mm 

4.000in 

20.32mm 
.800in 

1/2 NPT 
Both Sides 

126.16mm 
4.967in 

20.32mm 
.800in 

20.32mm 
.800in 

20.32mm 
.800in 



819-Series:

0 – 50 slpm 

0 – 100 slpm 
40.64mm 
1.600in 

110.92mm 
4.367in 

12.70mm 
.500in 

12.70mm 
.500in 

1/4 NPT 
Both sides 20.32mm 

.800in 
101.60mm 

4.000in 
20.32mm 

.800in 

82.55mm 
3.250in 4.45mm 

.175in 19.05mm 
.750in 

36.20mm 
1.425in 4X 8-32 UNC .375in[9.53mm] 

DATE 

1/4/2016 

REV. 

1 

250 slpm approximate shipping weight: 3.2 lb. 
M-250SLPM-D-MSPEC 
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82.55mm 
3.250in 

19.05mm 

.750in 

4.45mm 
.175in 

4X 8-32 UNC .375in[9.53mm] 

36.20mm 
1.425in 

50 slpm to 100 slpm approximate shipping weight: 2.4 lb. DATE 

1/4/2016 

M-50SLPM-D-MSPEC 
REV. 

1 

40.64mm 

1.600in 
0 – 250 slpm 

101.60mm 

4.000in 

20.32mm 
.800in 

1/2 NPT 
Both Sides 

126.16mm 
4.967in 

20.32mm 
.800in 

20.32mm 
.800in 

20.32mm 
.800in 
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RJ45 Connector Pin-Outs 

1 2 3 4 5 6 7 8 

RJ45 Device 

8 7 6 5 4 3 2 1 

RJ45 Cable 

1. RS-232 Receive

2. Ground

3. Analog Output

4. RS-232 Transmit

5. Power Supply

6. Power Supply

7. Analog Input

8. Ground
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Notes: 



Notes: 
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Serial Number:  

Model Number: 

166 Keystone Drive
Montgomeryville, PA 18936
800-828-4313
www.mathesongas.com
INT-0323 rev B

Copyright 2019 Matheson Tri-Gas, Inc. All Rights Reserved.

All contents of this document are subject to change without notice and do not represent a commitment on the part of Matheson Tri-Gas, Inc. 
Every effort is made to ensure the accuracy of this information. However, due to differences in actual and ongoing operational processes and 
product improvements and revisions, Matheson Tri-Gas, Inc. cannot guarantee the accuracy of this material, nor can it accept responsibility for 
errors or omissions. This document is intended to serve as a general orientation and cannot be relied upon for a specific operation. No warranties 
of any nature are extended by the information contained in these copyrighted materials.

All names, products, and services mentioned herein are the trademarks or registered trademarks of their respective organizations and are the sole 
property of their respective owners. Matheson and the Matheson logo are registered trademarks of Matheson Tri-Gas, Inc.

TERMS AND CONDITIONS OF SALE

http://www.mathesongas.com/pdfs/products/Terms-and-Conditions-of-Sale.pdf 
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